
10.01.14 Adobe Muse Помощь |  Строительство свой первый сайт с Muse |  Часть 8

helpx.adobe.com/muse/tutorials/building-your-first-website-part-8.html 1/15

Adobe Muse Помощь  / 
Строительство свой первый сайт с Muse | Часть 8

К началу

Группировка объектов и вставка группы на место

Использование встроенного HTML для отображения карты Google

Добавление значок в панели свойств сайта

Создание бесплатную пробную версию для публикации на сайте

Куда пойти отсюда

В части 7 Строительство свой ​​первый сайт с Muse , вы узнали, как добавить якоря теги

и связать их с пунктов меню в ручном горизонтальной виджета меню. Вы также узнали,

как прикрепить элементы на страницу, чтобы предотвратить их прокрутки. И вы

видели, как добавить ссылки на файлы, так что посетители могут скачать их. В части 8,

вы взгляните на группирования объектов и работы с группами, так что вы можете

вставить наборы содержания на страницах. Вы также работать с более встроенных

HTML-на этот раз, вы будете добавить интерактивную карту Google на страницу Visit.

И, наконец, вы увидите, как поставить штрихи на вашем сайте, добавив Favicon а затем

публикации пробный сайт, чтобы включенных хостингах.

Группировка объектов и вставка группы на место

Так же, как InDesign и других программ проектирования, вы можете объединить

несколько объектов в группу, чтобы они рассматриваются как единое целое. В этом

разделе вы создадите дизайн, состоящий из нескольких элементов (размещенные

изображения и текст кадров), а затем посмотреть, как сгруппировать их, чтобы сделать

его легко позиционировать или копировать их как один элемент. Выполните следующие

действия:

1. В плане, дважды щелкните миниатюру домашней страницы, чтобы открыть в

режиме конструктора.

2. Выберите Файл> Place. Обзор, чтобы выбрать файл в папке файлы примеров по

имени панели-открытым bottom.png. Нажмите кнопку Открыть, чтобы закрыть

http://helpx.adobe.com/muse/topics.html
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диалоговое окно Импорт, а затем один раз нажать в нижней части главной

страницы (ниже Состав виджета Лайтбокс и выше сноске) разместить рисунок в

полном размере.

Файл PNG был установлен на более низкую непрозрачность, так полупрозрачный

цветочный дизайн позволяет плитка фоновое изображение, чтобы показать через.

3. Выберите File> Place снова. На этот раз, просматривать, чтобы выбрать

изображение с именем ложка-map.png. Нажмите кнопку Открыть, а затем нажмите

один раз на верхнем лепестке центра, чтобы поместить его.

4. В то время как ложка изображение выбрано, нажмите и удерживайте Option (Mac)

или Alt (Windows), чтобы дублировать ложка изображение и перетащите его в

лепестке непосредственно справа от центра. Повторите эту операцию еще раз,

чтобы дублировать центр ложка изображение и перетащите дублируется копию

лепестка слева. Используйте инструмент Selection расположить три ложки, как

показано на рисунке 88 ниже.
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Рисунок 88. Расположите три ложки изображений в тройку лепестков дизайна.

5. Используя инструмент Текст, нарисуйте текстовое рамка в центре лепестка и

введите следующую команду:

Кэти Кафе

Ной Долина

123 Elizabeth Street

ПН-ПТ 6 утра-10 вечера

Сб-вс 7 утра-10 вечера

6. В поле Текст панели, применяются следующие настройки для форматирования

текста:

Шрифт: Droid засечками (или любой шрифт с засечками)

Размер шрифта: 14

Цвет шрифта: # 222222 (в части 5 вы переименовали этот цвет katieblack)

Выравнивание шрифта: Центр

Ведущий: 120%

7. Затем выбрать только две последние строки (которые начинаются с дней недели)

и установить цвет шрифта на красный (# A6342A).

8. Выделите текстовый фрейм с помощью инструмента Selection. Нажмите и

удерживайте Вариант (Mac) или Alt (Windows), чтобы дублировать текстовый

фрейм и перетащить его на лепестке сразу справа, над ложкой изображения.

Повторите эту операцию еще раз, чтобы дублировать центр текстовый фрейм и

перетащите дублированную копию лепестка слева. С помощью инструмента

Selection расположить три текстовых фреймов, чтобы они были выровнены выше

трех ложек, как показано на рисунке 89.
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Рисунок 89. Измените три адреса для отображения выше трех ложек в тройку лепестков дизайна.

9. Переключитесь на инструмент Text. Выделите текст в левом адрес и изменить его

на:

Кэти Кафе

Лорел Heights

800 Ель-стрит

ПН-ПТ 5 утра-12 утра

Сб-вс с 9 до 1 утра

10. Выделите текст в правильном адресе с помощью инструмента Текст и изменить

его на:

Кэти Кафе
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Коул долине

301 Кармель Улица

ПН-ПТ 7 утра-10 вечера

Сб-вс с 9 до 10 вечера

Теперь, когда проект будет завершен, вы будете выбирать элементы и группы их.

11. Используйте инструмент Selection, чтобы перетащить по всей конструкции цветка,

и обязательно выберите как размещенный цветка файл, три ложки изображения, и

три текстовых фреймов. Щелкните правой кнопкой мыши и выберите группу из

меню, которое появляется. Если вы предпочитаете, вы можете также выбрать

Object> Group.

Обратите внимание, что после группировки набор объектов, индикатор выбора в

верхнем левом углу панели управления отображается слово: Группа.

12. Скопируйте выбранную группу. Нажмите план, чтобы вернуться в вид сверху, а

затем дважды нажмите на миниатюру Посетить страницу, чтобы открыть его в

режиме конструктора. Выберите Edit> Paste на месте, чтобы разместить всю

группу элементов в том же месте.

Как можно понять из этого короткого, например, группы полезны, когда вы завершили

проект и вы хотите работать с ним как один элемент, чтобы изменить его на страницу

или скопировать его и вставить его на другую страницу.

В дополнение к группировке, вы также можете найти особенности Блокировка

предупредительным, как только вы завершили проект. Щелкните правой кнопкой мыши

на группе или выбранного набора элементов и выберите Блокировка из контекстного

меню, которое появляется, чтобы зафиксировать их. (В качестве альтернативы, вы

можете выбрать Object> Lock). Блокировка гарантирует, что вы не будете случайно

переместить или удалить любой из готовых элементов на странице, потому что они

больше не выбирается. Если в дальнейшем потребуется обновить заблокированные

элементы, выберите Object> Разблокировать все на странице.

После вставки цветок дизайн в нижней части страницы Визит, содержание страница

частично. В следующем разделе, вы будете продолжать редактировании страницы

Посетить добавить интерактивный интерфейс карту, чтобы помочь клиентам найти

ближайший кафе.
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по lynda.com - Джеймс

Фриц

Ответ на свой ​​опыт в 
Adobe Community Help

К началуИспользование встроенного HTML для отображения карты

Google

Ранее в этом уроке вы узнали, как вставлять HTML на страницы, чтобы добавить блог

Tumblr на странице событий. Вы также видели, как вставить Встроенный HTML внутри

Состав виджета Лайтбокс, для отображения видео YouTube в окне лайтбокс, когда

посетитель нажимает на кнопку. В этом разделе вы узнаете еще один тип встроенного

HTML, предоставляемой сайте Google Maps. Выполните следующие действия:

1. Если страница визит еще не открыт в режиме конструктора, нажмите план, а затем

дважды щелкните миниатюру посетить страницу, чтобы изменить его.

Этот исходный код был скопирован с maps.google.com сайте. Вы можете создать

пользовательскую карту в один адрес (или в данном случае, нескольких местах). Это

бесплатный сервис-вы просто указать адрес (или адреса) и нажмите кнопку Create Map

(см. рис 90).

http://www.adobe.com/community/publishing/download.html
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Рисунок 90. Нажмите Создать карту для создания карты на основе адресов вы вводите.

После создания карты, интерфейс Google Maps позволяет ввести название и описание.

Затем, вы можете нажать на кнопку Ссылка на доступ к коду. Выберите HTML код,

предоставленный в области с надписью: Вставить HTML для использования на сайте, и

вы готовы вернуться к Muse и вставлять HTML на странице (см. рис 91).
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Рисунок 91. С помощью интерфейса Google Maps для генерации HTML код для карте.

 

Для целей этого урока, это не необходимо создать новую карту самостоятельно. Если

вы предпочитаете, чтобы проверить его, эксперимент, введя любой адрес, создавая

карту, и скопировав код. Однако, если вы предпочитаете просто проверить, как это

работает, вы можете работать с некоторой предварительно сгенерированного HTML

кода.

2. Скопируйте исходный код ниже:

 

<Не ширина С даты = "887" высота = "298" frameborder = "0" прокрутка =

"нет" MARGINHEIGHT = "0" MARGINWIDTH = "0" </ IFRAME>

3. Вставьте код в верхней части страницы посещения. Используйте инструмент

Selection позиционировать встроенный HTML в вертикальном центре страницы, в

верхней, так что около четверти карте перекрывается с области заголовка. Не

забудьте оставить некоторое пространство между картой и цветочным графике

ниже него, так что вы можете добавить текстовое описание.
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4. Используйте инструмент Text перетащить текстовый фрейм ниже встроенном

карте. Скопируйте следующий текст и вставьте его в текстовый фрейм:

В то время как каждый из наших пекарен воплощает уникальные атрибуты его

окрестности, все они связаны друг с другом безупречным вниманием Кэти к деталям,

приверженность к обслуживанию, и, прежде всего, удовольствие от хорошей еды.

5. Используйте Text панель применять следующие параметры стиль текста:

Шрифт: Droid засечками (или любой шрифт с засечками)

Размер шрифта: 14

Цвет шрифта: # 222222 (в части 5 вы переименовали этот цвет katieblack)

Выравнивание шрифта: слева

Ведущий: 120%

После добавления описание к карте, на странице визит завершен.

6. Выберите Файл> Предварительный Страница в браузере, чтобы увидеть, как

появится страница визит в браузере (см. рис 92).

 

Рисунок 92. Готовое страницы визит включает в себя полнофункциональную карту Google.
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К началу

Обратите внимание, что встроенный HTML Google Карта является интерактивной. Вы

можете нажать на стрелки для перемещения по карте в пределах своей окне, и вы

также можете нажать кнопки + и - для увеличения и уменьшения изображения.

Дизайн сайта теперь заканчивается для всех страниц. В остальных разделах этого

учебника, вы увидите, как добавить последние штрихи и опубликовать сайт как

бесплатная пробная версия.

Добавление значок в панели свойств сайта

Favicon это небольшой, квадратное изображение, что вы создаете, добавить на сайт и

загрузить персонализировать закладки и URL. Хотя поведение меняется в зависимости,

какой браузер вы работаете, Favicon обычно отображается в адресной строке

браузера, рядом с URL сайта в то время рассматривается. Во многих случаях, он также

отображает рядом с именем страницы, когда она в закладки, или в закладке,

содержащей страницы загружаются сайта. Вы можете использовать любую программу

для редактирования изображений, такие как Photoshop или Illustrator, чтобы создать

квадрат (одинаково пропорции) файла изображения для использования в качестве

файл значок. Для этого урока, файл PNG предоставляется.

Выполните следующие действия, чтобы добавить значок на сайте:

1. Выберите Файл> Свойства сайта. Появится панель Свойства сайта.

2. На вкладке Макет щелкните значок папки справа от раздела Favicon. Используйте

диалоговое окно картинку Выберите Favicon который, кажется, перейдите к папке

файлы примеров и выберите файл с именем favicon.png (см. рис 93).
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К началу

 

Рисунок 93. Установите файл favicon.png в свойствах сайта.

3. Нажмите кнопку Открыть, чтобы закрыть диалоговое окно картинку Выберите

Favicon и выберите файл. Затем нажмите OK, чтобы закрыть диалоговое окно

Свойства сайта.

4. Выберите Файл> Предварительный просмотр сайта в браузере. Посмотрите в

верхней части окна браузера, чтобы увидеть значок отображается в адресной

строке. Если сайт загружается в закладке, вы также можете увидеть это

отображается там. И экспериментировать с закладки страницу, чтобы увидеть, как,

может отображаться символ рядом с названием страницы в список закладок.

Теперь, когда сайт будет завершен, следующий этап включает в себя загрузки на сайт,

чтобы предоставляемых хостинг-серверах Adobe Business Catalyst.

Создание бесплатную пробную версию для публикации на

сайте

После того как вы закончили разработке вашего сайта, следующим шагом будет
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выложить сайт. Процесс публикации очень простым и интуитивно понятным. Когда вы

впервые начали Muse, вы ввели Adobe ID, чтобы войти Вы будете использовать те же

имя пользователя и пароль, чтобы опубликовать все ваши сайты Muse.

1. Нажмите на ссылку Опубликовать на верхней левой стороне панели управления.

Опубликовать панель появляется, что позволяет ввести имя сайта и выбрать

временное URL (см. рис 94).

 

Рисунок 94. Введите имя сайта и URL, которые вы хотите использовать для пробного сайта.

2. Нажмите OK, чтобы начать процесс публикации.

Это может занять несколько минут, чтобы загрузить файлы на удаленном сервере.

Когда сайт закончил загрузку, дисплеи главной странице сайта в новом окне браузера.
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3. Нажмите ссылки в навигации по сайту верхнего уровня посещать страницы и

взаимодействовать с виджетами. Просмотрите все страницы и убедитесь, что

элементы отображения, как ожидалось. Делайте записи о любых вопросов,

которые будут исправлены.

4. Когда вы закончите, закройте браузер и вернуться к Muse.

Опубликовать панели обновила отображать кнопку ОК и ссылку Управление, которое

вы можете нажать, когда вы готовы, чтобы подтолкнуть сайт жить (которая включает в

себя начиная платный хостинг план, создание пользовательских доменное имя для

входа на сайт, и добавление пользователи).

Ваш опубликовал сайт будет использовать URL, подобный приведенному ниже. Вы

будете использовать этот адрес для доступа к страницам в браузере и делиться живой

сайт с другими:

http://my-trial.businesscatalyst.com

После того, как суд сайт опубликован, можно скопировать URL в адресной строке и

отправить ссылку для ваших клиентов, чтобы они могли рассмотреть живую версию

сайта. Это гораздо предпочтительнее, отправив им PDF макеты или вложения

электронной почты, потому что они могут просмотреть дизайн сайта в браузере.

Клиенты могут увидеть, как интерактивные функции ведут себя и утвердить рабочий

пример страницах.

После того как ваши клиенты или коллеги пересмотреть пробный сайт, они могут

просить изменения.

Если вы хотите обновить существующий пробный сайт, вы можете открыть файл. Муза

и продолжить редактировании страниц. Когда обновления закончены, нажмите кнопку

Опубликовать снова.

На этот раз, если вы хотите, чтобы заменить существующий пробный сайт с новыми

изменениями, выберите: Загружено: только измененные файлы (см. рис 95).

http://my-trial.businesscatalyst.com/
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К началу

 

Рисунок 95. Выберите опцию для обновления только новое содержание.

Куда пойти отсюда

Чтобы узнать больше о разработке веб-сайтов с Muse, проверить учебник под

названием Приступая к работе с Muse.  Также читайте Стратегии Muse поисковой

оптимизации (SEO).

 

Также не забудьте проверить Муза Учебники  страницу, чтобы узнать больше,

написанные учебники и посетить Muse События  страницу для живых вебинаров и

записанные видео-уроки.

См. Muse Сайт дня  странице, чтобы черпать вдохновение в других конструкций,

созданных в Muse, и погрузиться в работу с виджетами в Muse Widget Gallery .

http://www.adobekb.com/getting_started_01.html
http://www.adobekb.com/strategies_for_seo.html
http://www.adobekb.com/
http://muse.adobe.com/events.html
http://muse.adobe.com/site-of-the-day
http://muse.adobe.com/widget-gallery
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